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I. Mục đích 

Giới thiệu, hướng dẫn sinh viên tại Trường sử dụng các ứng dụng của Office 365. 

 

II. Phạm vi áp dụng 

Sinh viên được cấp quyền sử dụng Office 365 tại Trường UMT. 

 

III. Nội dung 

1. Giới thiệu tính năng Office 365 

Office 365 là bộ công cụ bao gồm các ứng dụng Word, PowerPoint, Excel, Outlook, 

Teams, Sharepoint, OneNote, Planner, OneDrive… cho phép người dùng tiếp cận, trải 

nghiệm trên tối đa 5 máy tính và các thiết bị di động khác. Office 365 có tùy chọn triển 

khai mới linh hoạt, người dùng có thể chọn để cài đặt các ứng dụng vào máy tính hoặc có 

thể sử dụng nền tảng web trực tiếp từ trang https://office.com 

2. Hướng dẫn cài đặt Office 365 

Có thể chạy Office 365 trên nền tảng web hoặc cài đặt Office 365 vào máy tính. Cụ thể 

như sau: 

Bước 1: Truy cập vào https://office.com  nhập tên tài khoản và mật khẩu được  cấp và 

nhấn Sign in để đăng nhập. 

 

 

 

 

https://office.com/
https://office.com/
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- Bước 2: Nhấn Install Office, chọn Office 365 apps phía trên góc phải trình duyệt. 

 

 
 

- Bước 3: Nhấn Save để tải tập tin cài đặt về máy tính (có thể tùy chọn đường dẫn đến thư 

mục để lưu tập tin). 
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Bước 4: Chạy tập tin OfficeSetup vừa tải về để tiến hành cài đặt Office 365 

 

 

Bước 5: Tiến trình cài đặt được Office 365 tự động thực hiện. 
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Bước 6: Cài đặt hoàn tất. Nhấn Close. 

 

 

Bước 7: Sau khi cài đặt xong, mở một ứng dụng bất kỳ, có thể là Word, Excel hoặc 

PowerPoint đều được. Office 365 sẽ yêu cầu kích hoạt bản quyền. Nhập tên tài khoản đã được cấp 

và nhấn Next để tiếp tục.
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Bước 8: Cửa sổ kế tiếp nhập tên tài khoản, password và nhấn Sign in để đăng nhập kích hoạt. 

 

 

 

Bước 9: Sau khi kích hoạt thành công, nhấn OK để tiếp tục 
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3. Hướng dẫn đăng nhập Office 365 bằng trình duyệt web 

Mở trình duyệt, vào link https://office.com đăng nhập bằng tên tài khoản và mật                       khẩu 

đã được cấp. 

 

 

Sau khi đăng nhập thành công, màn hình Dashboard hiện ra với các tính năng sử 

dụng Office 365 như bên dưới: 

 

 

https://office.com/
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4. Hướng dẫn quản trị tài khoản Office 365 

4.1 Hướng dẫn thay đổi mật khẩu 

Để thay đổi mật khẩu hiện tại, chọn Settings (1), rồi chọn Change your password (2) theo 

thứ tự như sau: 

 

Nhập các thông tin Old password (Mật khẩu cũ), New password (Mật khẩu muốn đổi), 

Confirm new password (Xác nhận mật khẩu muốn đổi) và nhấn Submit. 
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4.2 Hướng dẫn lấy lại mật khẩu 

Khi quên mật khẩu mà hệ thống trả về “We don’t recognize…” tức là người dùng đã 

nhập sai tên tài khoản hoặc mật khẩu. Nếu không nhớ mật khẩu đăng nhập người dùng vui lòng 

liên hệ với IT của Trường để lấy lại mật khẩu. 

4.3 Hướng dẫn quản lý thiết bị cài đặt 

4.4 Nhấn vào tên tài khoản ở góc trên bên phải Dashboard (1), chọn View account (2) 

Màn hình quản lý tài khoản xuất hiện 
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5. Hướng dẫn sử dụng các ứng dụng Office 365 

5.1 OneDrive for Business 

5.1.1 Giới thiệu 

OneDrive là dịch vụ lưu trữ đám mây có thể hoạt động trên nhiều hệ điều hành. 

OneDrive for Business cung cấp cho người dùng 1 TB lưu trữ dữ liệu, hỗ trợ lưu toàn bộ hình 

ảnh, video và các tài liệu quan trọng tại một không gian, đồng thời có thể truy cập dữ liệu từ 

nhiều thiết bị như máy tính, máy tính bảng, điện thoại chạy trên các hệ điều hành như Windows, 

Mac, Windows Phone, iOS, Android và Xbox. 

Người sử dụng OneDrive có thể cộng tác trực tuyến với 5 người cùng lúc thông qua tính 

năng Office Online để dễ dàng chia sẻ và làm việc cùng nhau trên Word, Excel, PowerPoint, 

thậm chí là OneNote Online. 

5.1.2 Các chức năng của OneDrive 

- Upload tập tin và thư mục. 

- Download tập tin và thư mục. 

- Chia sẻ tập tin và thư mục. 

- Cho phép nhiều người dùng tương tác trên 1 tập tin cùng thời điểm. 

5.1.3 Cách sử dụng 

* Upload tập tin và thư mục: vào trang chủ https://office.com, đăng nhập vào hệ thống 

bằng tài khoản Office 365. 

Sau đó chọn OneDrive --> Đây là nơi chứa các tập tin Word, Excel, PowerPoint… 

Khi lưu trực tuyến và các tập tin được người dùng upload lên Cloud. 

 

 

https://office.com/
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Để upload dữ liệu lên OneDrive, nhấn Upload --> có 2 lựa chọn Files hoặc Folder 

 

 
 

 
 

Thời gian upload tùy thuộc vào dung lượng tập tin và tốc độ đường truyền. Sau khi  upload xong, 

tập tin mới sẽ được nhìn thấy trên OneDrive 
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* Download tập tin và thư mục: Chọn đến tập tin/ thư mục cần download từ OneDrive 

rồi nhấn Download 

* Thực hiện tương tự cho các tác vụ Copy Link, Delete, Move to, Copy to và Rename. 

* Quản lý tập tin và thư mục trong OneDrive: để tạo mới, chọn New --> có thể tùy 

chọn tạo mới Thư mục hoặc các tập tin Word, Excel, PowerPoint… 
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* Chia sẻ tập tin và thư mục: Để chia sẻ tập tin hay thư mục, chọn Share 

--> Điền email của người muốn chia sẻ tập tin hoặc thư mục. 

 
 

Chọn Can view nếu muốn người được chia sẻ chỉ có quyền đọc tập tin, chọn Can  edit 

nếu muốn người đó có thể chỉnh sửa tập tin, sau đó nhấn Send. 



18 

 

TRƯỜNG ĐẠI HỌC QUẢN LÝ & 

CÔNG NGHỆ TP.HCM 

Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

* Xem thư mục tài khoản được chia sẻ: để xem thư mục người khác chia sẻ cho  mình, 

nhấn Shared, chọn Shared with you. Khi đó sẽ thấy được tập tin/ thư mục được chia sẻ, thời 

gian được chia sẻ và người chia sẻ. 

* Cùng làm việc trên tập tin: tương tác là tính năng nổi bật của Office 365. Trên một 

tập tin được chia sẻ, người dùng không cần phải gửi tài liệu qua lại bằng mail. Người dùng có 

thể dễ dàng thêm, trả lời, theo dõi và cập nhật tài liệu trên một phiên bản. Các tập tin luôn được 

cập nhật, vì vậy mọi người đều được tiếp cận với phiên bản có nội dung mới nhất. Office 365 

hỗ trợ tối đa 05 người cùng làm việc trên 1 tập tin cùng một thời điểm. Các bước thực hiện: 

Bước 1: Tài khoản A chia sẻ cho tài khoản B tập tin Bia phan trang.docx 
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Bước 2: Tài khoản B chọn tập tin cần chỉnh sửa --> nhấn chuột phải,  chọn Open --> 

Open in browser. 

 

Bước 3: Khi tài khoản B tương tác trên tập tin Bia phan trang.docx sẽ hiện tài khoản 

đang tương tác và tình trạng (tập tin đã được lưu hay chưa). 

 

Đồng bộ OneDrive với máy tính cá nhân: 

 

- Download tập tin cài đặt: 

Truy cập đường link https://www.microsoft.com/en-ww/microsoft-365/onedrive/download   

 

 

 

 

https://www.microsoft.com/en-ww/microsoft-365/onedrive/download
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DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

 

Chạy tập tin vừa download về. 

  Đăng nhập bằng tài khoản Office 365 
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Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Sau khi đăng nhập bằng ở máy tính xuất hiện thư mục OneDrive – xxxxxx tương tự như 

OneDrive trên giao diện web. 

* Lưu ý: Mỗi tài khoản OneDrive được sử dụng 1 TB dữ liệu và để sử dụng tối đa tài 

nguyên trên OneDrive ta có thể cài đặt cho một số thư mục chỉ định đồng bộ   hoặc không 

đồng bộ với máy tính cá nhân như sau: 

Chọn tab Account --> Choose folders --> Chọn hoặc bỏ chọn các thư mục cần đồng 

bộ, sau đó chọn OK 
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
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Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

 

5.2 Microsoft Sway 

5.2.1 Giới thiệu 

Sway là công cụ giúp người dùng tạo ra và chia sẻ những nội dung trình chiếu trực tuyến. 

Sway được xem là phiên bản cải tiến của công cụ thuyết trình nổi tiếng PowerPoint. Sway được 

thiết kế tối ưu cho việc trình chiếu và chia sẻ dữ liệu với nhiều người dùng cùng lúc. 

Sway có thể tạo những nội dung trình chiếu bằng những thao tác  kéo/ thả trực tuyến. 

Sau khi hoàn thành, các nội dung trình chiếu sẽ được lưu trữ trên nền tảng điện toán đám mây 

(Cloud). Người dùng có thể chia sẻ với mọi người xung quanh thông qua các mạng xã hội hoặc 

nhúng vào web. 

Sway có thể được nhập dưới nhiều dạng dữ liệu: văn bản, hình ảnh, video cho đến những 

đoạn tweet trên Twitter. Sway cũng tự động điều chỉnh bố cục cho phù hợp với nhiều loại thiết 

bị khác nhau từ máy tính, TV màn ảnh rộng cho tới máy tính bảng, smartphone... 

Sau khi hoàn thành nội dung trình chiếu, người dùng có thể chia sẻ ngay lên các mạng 

xã hội như Facebook, Twitter, gửi liên kết qua email hoặc nhúng vào trang web yêu thích. Đặc 

biệt, người xem có thể chia sẻ hoặc tương tác trực tiếp  với các nội dung trình chiếu. Các hiệu 

ứng của Sway cũng đẹp mắt không kém gì PowerPoint. 

 

 

 

 



23 

 

TRƯỜNG ĐẠI HỌC QUẢN LÝ & 

CÔNG NGHỆ TP.HCM 

Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
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và Chuyển đổi số 
Ngày duyệt:  

 

 

5.2.2 Các chức năng của Sway 

- Tạo slide mở đầu. 

- Tạo slide nội dung. 

- Tùy biến, hoàn thiện slide. 

- Chia sẻ slide. 

 

5.2.3 Cách sử dụng 

* Tạo slide mở đầu: vào trang chủ https://office.com, đăng nhập vào hệ           thống bằng 

tài khoản Office 365, sau đó nhấn chọn Sway. 

 

 

 

 

 

 

https://office.com/
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Nhấn New blank Sway. 

 

 

Nhấn Insert (1) chọn ảnh nền chủ đề của nội dung trình chiếu hoặc kéo thả hình ảnh thả 

vào Storyline. Thực hiện theo thứ tự như hình dưới. 

 

Trong đó:  

 

(2) hình đại diện cho chủ đề.  

(3) chủ đề bài giảng. 

(4) tìm kiếm ảnh       qua Internet. 

(5) mở thêm slide mới.  
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Nhấn Play để chạy slide, Nhấn Esc để quay trở lại màn hình chỉnh sửa. 

 
 

* Tạo slide nội dung: Tạo phần nội dung chính cho nội dung trình chiếu. Ở ngay bên 

dưới     khung tiêu đề có dấu + màu xanh, nhấn vào dấu + rồi chọn Heading. Heading ở đây chính 

là tiêu đề cho một slide nhỏ trong bài giảng. Tạo xong heading rồi tạo đến nội dung muốn trình 

chiếu như trong hình minh họa bên dưới theo các công cụ được mô tả như sau. 
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Tiếp tục thêm những heading khác và nội dung khác cho đến khi hoàn tất nội dung trình chiếu. 

 

* Tùy biến, hoàn thiện 

- Để chọn phong cách và hiệu ứng chuyển cảnh một cách thủ công, nhấn Design, sau đó 

nhấn Styles để tùy chọn. Chọn xong nhấn Play để xem thử. 

- Dùng nút Remix, Sway sẽ tự động chọn các bộ kết hợp giữa hiệu ứng chuyển cảnh, 

font chữ và tông màu khác nhau. 
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                   * Chia sẻ 

Để gửi link nội dung trình chiếu này cho người khác, nhấn vào nút Share như trong hình 

dưới, sau đó lấy link. Có thể chia sẻ lên Facebook, Google + và nhiều mạng xã hội khác. 

 

5.2.4 Các tài liệu và đường link tham khảo 

Dưới đây là các link tham khảo, để hoàn thiện nội dung trình chiếu tốt nhất: 

 

https://sway.com/wEK9vynxN7Pv4UGR 

https://www.youtube.com/watch?v=W9913w-GZlw 

https://www.youtube.com/watch?v=DBjqjZE20I4 

5.3 Microsoft Forms 

5.3.1 Giới thiệu 

Microsoft Forms là một ứng dụng của Microsoft có trong bộ Office 365. Microsoft 

Forms dung để tạo bản khảo sát dùng để thu thập thông  tin, ý kiến, Microsoft Forms có thể 

tạo những bài kiểm tra, đố vui (Quiz) sử dụng trong giảng dạy. 

5.3.2 Các chức năng của Forms 

- Tạo lập Forms. 

- Thiết lập Forms. 

 

 

 

https://tinhte.vn/go-to/aHR0cHM6Ly9zd2F5LmNvbS93RUs5dnlueE43UHY0VUdS
https://www.youtube.com/watch?v=W9913w-GZlw
https://www.youtube.com/watch?v=DBjqjZE20I4
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5.3.3 Cách sử dụng 

* Tạo lập Forms: vào trang chủ https://office.com, đăng nhập vào hệ thống bằng tài 

khoản Office 365, sau đó chọn Forms. 

 

Nhấn vào New Quiz 

 

https://office.com/
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Nhấn vào Untitled quiz, điền các thông tin cần thiết về tên (1) và mô tả (2). 

 

 

Nhấn Add new, Microsoft Forms cho phép ta chọn nhiều loại câu hỏi như  hình dưới. 
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Choice: Phục vụ cho các câu hỏi dạng Multiple choices hoặc câu hỏi dạng Check-box. 

Nhập câu hỏi cần hỏi (1). Chọn hình ảnh muốn xuất hiện trong câu hỏi (2).  Nhập các lựa chọn 

trả lời bên dưới. Để thêm lựa chọn, nhấn Add option (3). Cho phép người trả lời chọn nhiều 

câu trả lời, bật Multiple answers (4). Nếu muốn câu   hỏi ở dạng bắt buộc thì bật Required 

(5). Nhấn nút … (7) để có các tùy chọn khác như Subtitle, Shuffle options…. 

 

 

Text: Phục vụ cho các câu hỏi dạng Tự luận. Ở đây Forms hỗ trợ Long answer (1) được 

dùng cho các câu trả lời dài như viết đoạn văn. Ngoài ra, có thể nhấn ... (2) để có thêm các tùy 

chọn câu trả lời chỉ chứa số, thỏa mãn các điều kiện, giới hạn… 
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Rating: Phục vụ cho các câu hỏi về đánh giá theo các mức độ 1-10 (1). Microsoft 

Forms hỗ trợ biểu tượng hình sao (Star) hoặc số (Numbers) cho loại  đánh giá này (2). Có 

thể nhấn … để có thêm lựa chọn định nghĩa mức 1 Star/ 5 Star và chức năng khác (3). 

 

Date: Phục vụ cho việc thu thập dữ liệu liên quan đến ngày tháng như hỏi về ngày tháng 

năm sinh. 
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Nhấn Preview để xem lại Form 

 

Nhấn Theme nếu ta có muốn thay đổi giao diện 
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* Cài đặt cho Forms: sau khi soạn thảo xong forms, có thể nhấn vào “…” và chọn 

Settings để tùy biến.  

 
 

 

Phần Who can fill out this form để kiểm soát xem ai sẽ có thể thao tác trên Form này. 

 

- Có 2 lựa chọn: Only people in my organization can respond là người trong tổ chức 

(có email @st.umt.edu.vn) và Anyone can respond là bất kỳ ai   có link này. 

 

 

 



34 

 

TRƯỜNG ĐẠI HỌC QUẢN LÝ & 

CÔNG NGHỆ TP.HCM 

Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
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Phần Options for responses:  

+ Accept responses: Lựa chọn này cho biết Form có thể nhận phản hồi không. Điều 

này có nghĩa là ta có thể tạo Form trước, nhưng không cho người xem trả lời Form. 

+ Start Date: Thiết lập ngày bắt đầu cho trả lời Form. 

+ End Date: Thiết lập hạn chót cho Form. 

+ Shuffle questions: Sắp xếp câu hỏi theo thứ tự ngẫu nhiên mỗi lần vào Form. 

+ Customize thank you message: Soạn nội dung cám ơn người làm khảo sát 

 

5.3.4 Các tài liệu và đường link tham khảo 

https://support.office.com/en-us/forms 

https://www.youtube.com/playlist?list=PL0LULDZ8T3gR5UV3_m7Lcc4wUI 

Qwz8HsX 

 

 

 

 

 

 

 

https://support.office.com/en-us/forms
https://www.youtube.com/playlist?list=PL0LULDZ8T3gR5UV3_m7Lcc4wUIQwz8HsX
https://www.youtube.com/playlist?list=PL0LULDZ8T3gR5UV3_m7Lcc4wUIQwz8HsX
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5.4 Microsoft OneNote 

5.4.1 Giới thiệu 

OneNote như một quyển sổ tay là nơi có thể lưu trữ thông tin và các ghi chú – mọi thứ 

cần ghi nhớ và quản lý. 

OneNote dễ sắp xếp, chia sẻ và có khả năng tìm kiếm nhanh. 

5.4.2 Chức năng của OneNote 

- Tạo hoặc chèn thông tin vào sổ tay. 

- Cộng tác với người khác trong sổ tay dùng chung. 

- Phân biệt nội dung ghi chú bằng cách sử dụng thẻ và tô sáng. 

- Truy nhập thông tin, dữ liệu cập nhật từ hầu hết mọi thiết bị. 

5.4.3 Cách sử dụng 

Giới thiệu cơ bản giao diện làm việc: 
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- (1) Thanh công cụ Ribbon gồm các chức năng chính cho soạn thảo ghi chú. 

- (2) Danh sách các sổ tay (Notebooks) đã tạo. 

- (3) Các phần trong sổ tay (Sections). 

- (4) Khung tìm kiếm trong trang hiện tại hoặc tất cả các sổ tay cùng lúc. 

- (5) Thêm một trang mới (Page) trong sổ tay (Page nằm trong Sections). 

- (6) Vùng soạn thảo ghi chú trong sổ tay. 

 
Tạo mới một Notebook (Sổ tay): 

Bước 1: Nhấn File --> New 
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Bước 2: Chọn nơi có thể lưu Notebooks (Ví dụ: OneDrive) hoặc trên máy tính  cá nhân 

(This PC). 

Bước 3: Sau khi lưu thành công, sẽ thấy Section mới được tạo. 

 

Mặc định section mới là trang trắng, nếu thích trang trí có thể chọn các mẫu  có sẵn trong 

một trang mới bằng cách chọn Insert -> Page Templates 
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Thêm Section và trang (Add page): 

- Section trong OneNote giống như các thẻ màu chủ đề trong sổ tay giấy. Không  như 

giấy, OneNote cho phép tạo ra nhiều section trong một sổ tay (Notebook). Để thêm Section ta 

thực hiện như sau: 

Bước 1: Click chuột phải vào bất kỳ thẻ nào (section) trên cùng của trang chọn 

New Section 

 

Bước 2: Nhập tiêu đề cho section mới và nhấn Enter. Để thay đổi vị trí giữa các 

section, nhấn giữ chuột trái vào một Section bất kỳ và kéo đến vị trí mong muốn. 

- Trong một section có nhiều trang (Page) tùy nhu cầu người sử dụng và mục 

đích công việc. Để thêm trang làm như sau: 
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Bước 1: Nhấn vào Add page (1) nằm phía bên phải trang 

 

Bước 2: Nhập tiêu đề vào phần Header (2) cho trang sau đó nhấn Enter. Để thay đổi vị 

trí giữa trang, nhấn giữ vào trang bất kỳ cần thay đổi và kéo đến vị trí mong  muốn. 

 

Nhập hoặc xóa ghi chú, gán thẻ cho ghi chú: 

- OneNote cho phép chọn bất cứ nơi nào trong khung soạn thảo (1) và bắt đầu nhập 

dữ liệu (2), (3). 

- Nhấn giữ chuột trái mũi tên màu xám như trong hình và di chuyển đến vị trí  mong 

muốn (4). 
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- Xóa ghi chú 

- Sử dụng các công cụ vẽ trong thẻ Draw để vẽ trong ghi chú hoặc sử dụng các 

đối tượng có sẵn trong công cụ Shapes (1) 
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- Gán thẻ cho ghi chú 

Bước 1: Đặt con trỏ ở đầu dòng văn bản. 

Bước 2: Trong thẻ Home chọn một thẻ muốn gán trong mục Tags 

 
 

Thêm liên kết (link), hình ảnh và tập tin vào một trang: 

- Thêm liên kết (link) vào ghi chú: khi gõ một đoạn văn bản mà OneNote nhận ra dưới 

dạng một liên kết thì nó sẽ tự động định dạng như một đường link. Ví dụ như khi nhập Error! 

Hyperlink reference not valid.vào ghi chú, OneNote sẽ chuyển thành một kết nối, khi bấm 

vảo kết nối này sẽ mở trang web Office trong trình duyệt. Có thể thêm link vào trong phần ghi 

chú (bao gồm cả chữ, hình ảnh, đến những trang khác và section) với các bước như sau: 

Bước 1: Chọn đoạn chữ hoặc hình ảnh muốn thêm link 

Bước 2: Nhấn Insert --> Link 

Bước 3: Trong hộp thoại Link, nhập nội dung liên kết vào phần Address, sau đó nhấn OK. 



42 

 

TRƯỜNG ĐẠI HỌC QUẢN LÝ & 

CÔNG NGHỆ TP.HCM 

Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

 
 

* Thêm hình ảnh vào ghi chú: Thêm một hay nhiều hình ảnh vào trong ghi 

chú như sau: 

Bước 1: Trong bất kì trang nào, chọn nơi muốn thêm hình vào. 

Bước 2: Nhấn Insert, sau đó theo một trong các tùy chọn: 

+ Nhấn Screen Clipping để chụp một phần màn hình máy tính và thêm vào note như 

một hình. 

+ Nhấn Pictures để thêm một file hình được lưu trên máy tính hoặc ổ đĩa khác,  hoặc 

USB. 

+ Nhấn Online Pictures để tìm và thêm hình từ trang tìm hình ảnh của Bing,  OneDrive 

hoặc một trang web nào đó. 
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- Thêm tập tin vào ghi chú: OneNote có khả năng lưu trữ toàn bộ thông tin về các chủ 

đề, dự án lại với nhau trong cùng một nơi bao gồm những bản copy của các tài liệu và tập tin 

liên quan. Thêm tập tin vào ghi chú như sau: 

Bước 1: Trong note, chọn trang muốn thêm tập tin hoặc tài liệu vào. 

Bước 2: Click Insert --> File Attachment. 

Bước 3: Trong hộp thoại Choose a file or a set of files to insert, chọn một hoặc  nhiều 

tập tin và nhấn Insert. 

Những tập tin đã được thêm vào hiển thị như một icon trên trang. Nhấp đúp chuột vào 

tập tin để mở lên.
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Thêm bảng và sắp xếp thông tin trong bảng 

Bảng biểu là cách tuyệt vời để tổ chức và sắp xếp thông tin trong các ghi chú. Tạo 

bảng trong OneNote như sau: 

Bước 1: Click Insert --> Table. 

Bước 2: Di chuyển con chuột trên lưới để chọn kích thước bảng mong muốn, sau đó 

nhấn chuột trái để thêm table. Ví dụ, khi chọn table 6x4 sẽ tạo ra một table có 6 cột và 4 dòng. 
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Hoặc có thể click Insert --> Table --> Insert Table… để nhập số hàng , cột như ý và nhấn 

OK để tạo bảng. 

 

 

 

Để sửa đổi bảng hoặc bất kỳ thành phần nào của bảng, nhấn chuột vào bất kỳ ô nào 

trong bảng, sau đó bấm vào thẻ Layout trên ribbon. Các công cụ bảng cho phép ta chèn và loại 

bỏ các hàng và cột, chọn viền bảng và sắp xếp các ô, dữ liệu trong bảng,  ô và phạm vi ô, hiện 

hoặc ẩn đường viền. 
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Nếu dữ liệu trong bảng quá phức tạp thì có thể chuyển sang dạng bảng tính Excel ngay 

trong OneNote. Click chuột vào Layout, chọn Convert to Excel Spreadsheet. Bây giờ chúng 

ta có thể tính toán trên bảng trung gian thông qua Excel. 

 

 
 

 

Lưu và đồng bộ sổ tay, chia sẻ công việc 

- Lưu và đồng bộ sổ tay: OneNote không có nút Save. OneNote tự động lưu và 

đồng bộ tất cả dữ liệu trên chính nó. 

- Chia sẻ ghi chú trực tuyến và công việc với người khác: 

Bước 1: Nhấn File --> Share 

Bước 2: Chọn Share with People. Nhập username hoặc email người cần share (1) và chọn 

chế độ cho người được chia sẻ Can edit hoặc Can view (2). Nhấn nút Share để thực hiện. 
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5.5 Microsoft Planner 

5.5.1 Giới thiệu 

Planner là một ứng dụng hữu ích giúp quản lý công việc, quản lý kế hoạch theo 

cách đơn giản, dễ tương tác với một giao diện gọn gàng, hợp lý. 

5.5.2 Chức năng của Planner 

- Tạo kế hoạch mới, xây dựng nhóm, phân công tác vụ và cập nhật trạng thái. 

- Đính kèm tập tin vào các tác vụ, phối hợp thao tác trên tập tin. 

- Hoạt động trên nhiều thiết bị. 

- Thông báo email. 

5.5.3 Cách sử dụng 

Vào trang chủ https://office.com, đăng nhập vào hệ thống bằng tài  khoản Office 365, 

sau đó chọn Planner. 

 

 

 

Tạo Planner: Chọn New plan --> Gõ tên kế hoạch --> Chọn Create plan

https://office.com/
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* Thêm người dùng tham gia kế hoạch: nhấn Members --> Gõ tên người 

dùng muốn thêm hoặc email rồi nhấn Enter 

 

 
 

* Quản lý tác vụ: Nhấn Add new bucket --> Gõ tên của bucket --> Nhấn + 

Add task --> Gõ tên tác vụ --> Chọn ngày kết thúc tác vụ --> Phân công thành viên --> 

Nhấn Add task 
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Đính kèm tệp và chỉnh sửa dự án: 

 

 

Nhấn vào bucket cần chỉnh sửa (1); chọn Bucket để chuyển đổi giữa các bucket, 

chọn Progress (tiến độ), chọn Start date (ngày bắt đầu), chọn Due date (ngày kết thúc)…. 

để bổ sung thông tin cho dự án. 

* Xem tất cả dự án đang có/ đang thực hiện: nhấn Hub 
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* Xem nhiệm vụ được phân công: nhấn Assigned to me 

 

 

* Xem biểu đồ tiến độ: nhấn Charts 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



51 

 

TRƯỜNG ĐẠI HỌC QUẢN LÝ & 

CÔNG NGHỆ TP.HCM 

Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

5.6 Microsoft Teams 

5.6.1 Giới thiệu 

Microsoft Teams hỗ trợ mô hình Connector như Exchange nhằm cung cấp cảnh báo và 

cập nhật các dịch vụ của đối tác thứ ba, như Twitter hoặc GitHub một cách trực tiếp. Microsoft 

Teams cũng hỗ trợ Microsoft Bot Framework để đem lại các dịch vụ thông minh của cả 

Microsoft và đối tác thứ ba lên môi trường làm việc nhóm. Tất cả hội thoại, dữ liệu đi qua 

Microsoft Teams đều được mã hoá. 

5.6.2 Chức năng của Microsoft Teams 

- Công cụ hội thoại nhóm (group chat) 

- Hỗ trợ cuộc họp hội thoại, video. 

- Có thể làm việc bằng tài liệu Microsoft Office. 

- Hỗ trợ Microsoft Graph. 

- Hỗ trợ tối ưu và đặc thù hoá cho từng mục đích làm việc. 

5.6.3 Cách sử dụng 

Vào trang chủ https://office.com, đăng nhập vào hệ thống bằng tài khoản Office 365, 

sau đó chọn Teams. 

* Nhóm (Teams): Nhóm được thiết kế để tập hợp một nhóm người phối hợp chặt chẽ. 

Nhóm có thể thay đổi cho công việc dựa trên mục đích cụ thể. Chỉ các thành viên trong  

nhóm mới nhìn thấy nội dung công việc bên trong nhóm. 

https://office.com/
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* Kênh (Channels): Kênh giúp tổ chức cuộc trò chuyện, nội dung và công cụ của nhóm 

xoay quanh một chủ đề cụ thể. Có thể tổ chức kênh, chẳng hạn như theo chủ đề (sự kiện), nguyên 

tắc (thiết kế), dự án (triển khai) hoặc giải trí (nội dung). Chủ sở hữu nhóm có thể tạo kênh và 

cho phép các thành viên nhóm tạo kênh khi cần. 
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* Tư cách thành viên Nhóm: các chủ sở hữu nhóm được chỉ định có thể mời bất kỳ 

thành viên nào cùng làm việc với họ gia nhập nhóm. Microsoft Teams giúp chủ sở hữu nhóm 

dễ dàng thêm người vào tổ chức theo tên.  

Chủ sở hữu nhóm cũng có thể tạo nhóm dựa trên Nhóm Office 365 hiện tại.  Mọi 

thay đổi được thực hiện với nhóm sẽ được tự động đồng bộ hóa với Microsoft Teams. Microsoft 

Teams hiện không hỗ trợ người dùng bên ngoài tổ chức tham gia nhóm. 

* Vai trò của Nhóm: Có hai vai trò chính trong Microsoft Teams: chủ sở hữu nhóm, 

người tạo nhóm và thành viên nhóm, những người họ mời tham gia nhóm. Chủ sở hữu nhóm có 

thể chỉ định thành viên bất kỳ trong nhóm là người đồng sở hữu khi mời họ tham gia nhóm hoặc 

vào bất kỳ thời điểm nào sau khi họ vào nhóm. Có nhiều chủ sở hữu nhóm cho phép chia sẻ 

trách nhiệm quản lý cài đặt và tư cách thành viên, bao gồm thư mời. 
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* Tính năng Chat 

 

 

 * Tính năng Call Video 

 

 

 

***Xem thêm hướng dẫn tại  

https://www.youtube.com/watch?v=2zB2jiCxxuQ 

https://www.youtube.com/watch?v=2zB2jiCxxuQ
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5.7 Microsof Word Online 

Tại màn hình Dashboard, chọn ứng dụng tương ứng. 

 

Để tạo một văn bản mới, chọn New blank document 
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Nhập nội dung văn bản 

 

Khi muốn lưu văn bản, nhấn File → Save as 
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CÔNG NGHỆ TP.HCM 

Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Điền tên tập tin, đường dẫn thư mục muốn lưu tập tin, nhấn Save. 

Nếu muốn lưu tập tin vào máy, Chọn File --> Save as --> Download a Copy 

 

Để mở một tập tin trên Word, chọn File --> Open --> Chọn tập tin cần mở. 

Nếu không thấy tập tin cần mở đó trong mục Recent, chọn View more files để mở 

OneDrive và tiếp tục tìm kiếm tập tin cần mở 
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Để chỉnh sửa tài liệu, nhấn Editing --> Editing để chỉnh trực tiếp trên trình duyệt web 

hoặc có thể chọn Open in Desktop app để chỉnh sửa bằng ứng dụng Word trên máy 

tính. 
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Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

5.8 Microsof Excel online 

Sử dụng Excel Online, tại màn hình Dashboard, chọn ứng dụng tương ứng. 

 

Để tạo một bảng tính mới, chọn New blank workbook 
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Nhập nội dung. 

 

 
 

Khi muốn lưu, chọn File → Save As. Điền tên tập tin, chọn đường dẫn muốn lưu tập 

tin, nhấn Save.  
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
TÀI LIỆU HƯỚNG DẪN SỬ 

DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Nếu muốn lưu tập tin vào máy, Chọn File --> Save As -> Download a Copy 

 

 
 

Để mở một tập tin, chọn File --> Open -> Nhấn vào tập tin cần mở 

Nếu không thấy tập tin cần mở đó trong mục Recent, chọn View more files để mở 

OneDrive và tiếp tục tìm kiếm tập tin cần mở. 
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  
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Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Để chỉnh sửa tài liệu, nhấn Editing --> Editing để chỉnh trực tiếp trên trình duyệt web 

hoặc có thể chọn Open in Desktop app để chỉnh sửa bằng ứng dụng Excel trên máy 

tính. 

 

 

 

5.9 Microsof PowerPoint online 

Sử dụng Powerpoint Online, tại màn hình Dashboard, chọn ứng dụng tương ứng. 
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Biên soạn:  
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DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Để tao nội dung trình chiếu mới, chọn New blank presentation 

 

 

Nhập nội dung. 
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và Chuyển đổi số 
Ngày duyệt:  

 

 

Khi muốn lưu nội dung, nhấn File → Save as 

 

 

Điền tên tập tin, chọn đường dẫn lưu tập tin, nhấn Save.  

Nếu muốn lưu tập tin vào máy, Chọn File --> Save As --> Download a Copy 
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DỤNG OFFICE 365 

Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Để mở một tập tin trên, chọn File --> Open --> Chọn tập tin cần mở. Nếu không thấy 

tập tin cần mở đó trong mục Recent, chọn View more files để mở OneDrive và tiếp 

tục tìm kiếm tập tin cần mở. 

 

 
 

 

Để chỉnh sửa tài liệu, nhấn Editing --> Editing để chỉnh trực tiếp trên trình duyệt web 

hoặc có thể chọn Open in Desktop app để chỉnh sửa bằng ứng dụng PowerPoint trên 

máy tính. 
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và Chuyển đổi số 
Ngày duyệt:  

 

 

5.10 Cài đặt Office trên điện thoại 

5.10.1 Cài đặt trên Iphone 

Mở App Store 

 

 
 

Tìm đến ứng dụng Office, nhấn nút cài đặt. 
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Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Nhấn Open để mở ứng dụng 

Chọn Sign in, điền thông tin tài khoản Office 365 
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Mã tài liệu:  

Phiên bản số:  

Biên soạn:  

Tài liệu CNTT 
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Phê duyệt:  

Phòng Công nghệ thông tin 

và Chuyển đổi số 
Ngày duyệt:  

 

 

Nhập mật khẩu, chọn Sign in 

 

Sau khi đăng nhập thành công, các tài liệu sẽ được đồng bộ theo tài khoản. 
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và Chuyển đổi số 
Ngày duyệt:  

 

 

5.10.2 Cài đặt trên điện thoại Android 

Mở Google Play, tìm đến ứng dựng Office, nhấn Install. 

 

Nhấn Open để mở ứng dụng 
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và Chuyển đổi số 
Ngày duyệt:  

 

 

Chọn Sign in, điền thông tin tài khoảng Office 365. 

Nhập mật khẩu, chọn Sign in. 
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và Chuyển đổi số 
Ngày duyệt:  

 

 

Sau khi đăng nhập thành công, các tài liệu sẽ được đồng bộ theo tài khoản. 

 

 

 

 

 

 

 

 

 

KẾT THÚC 


